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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by you 
or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of 
third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  No 
license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of 
Renesas Electronics or others. 

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.  
Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration, 
modification, copy or otherwise misappropriation of Renesas Electronics product. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”.  The 
recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.   
“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 

equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-

crime systems; and safety equipment etc. 
Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property 
damages (nuclear reactor control systems, military equipment etc.).  You must check the quality grade of each Renesas 
Electronics product before using it in a particular application.  You may not use any Renesas Electronics product for any 
application for which it is not intended.  Renesas Electronics shall not be in any way liable for any damages or losses incurred 
by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas 
Electronics. 

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics.  Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions.  Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas 
Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and 
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because the evaluation 
of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by 
you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility 
of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable laws and 
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.  
Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws 
and regulations. 

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations.  You should not use 
Renesas Electronics products or technology described in this document for any purpose relating to military applications or use 
by the military, including but not limited to the development of weapons of mass destruction.  When exporting the Renesas 
Electronics products or technology described in this document, you should comply with the applicable export control laws and 
regulations and follow the procedures required by such laws and regulations. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise 
places the product with a third party, to notify such third party in advance of the contents and conditions set forth in this 
document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of 
unauthorized use of Renesas Electronics products. 

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document 
or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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How to Use This Manual

Readers This manual is intended for users who are using RL78 Family and RX Family in the 

design and development of application systems.

Purpose This manual is intended to bring users to understand the functions of the CubeSuite+ 

Partner OS Aware Debugging Plug-in, and its organization is as listed below.

Organization This manual consists of the following major sections.

CHAPTER 1   GENERAL
CHAPTER 2   FUNCTIONS
APPENDIX A   WINDOW REFERENCE
APPENDIX B   Messages
APPENDIX C   Notes

How to Read This Manual It is assumed that the readers of this manual have general knowledge in the fields of 
electrical engineering, logic circuits, microcontrollers, the C language, and assembly 
languages.

To understand the hardware functions of the RL78 Family or RX Family
-> Refer to the User's Manual for the given product.

Conventions Data significance: The higher-order digits are to the left and the lower-order
digits are to the right

Note: Footnotes for items marked with "Note" in the text
Caution: Information requiring particular attention
Remark: Supplementary information
Numeric representation: Decimal             XXXX

Hexadecimal     0xXXXX
Prefixes indicating powers of 2 (for address spaces and memory capacities):

K (kilo) 210 = 1024
M (mega) 220 = 10242



All trademarks or registered trademarks in this document are the property of their respective owners.

uC/OS-III is a trademark of Micrium, Inc.
embOS is a trademark of SEGGER Microcontroller Systems.
UCT uT-Kernel DevKit tuned is a trademark of Ubiquitous Computing Technology Corporation.
NORTi is a registered trademark of MiSPO Co., Ltd.
Smalight is a registered trademark of Renesas Northern Japan Semiconductor, Inc.
T-Engine Forum holds the copyright on the uT-Kernel specifications.
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CHAPTER  1   GENERAL

CubeSuite+ is an integrated development environment for use in tasks such as design, coding, building and debugging 
in the development of application systems for microcontrollers manufactured by Renesas Electronics.

This manual describes the tool, which is useful for debugging programs that employ real-time OS from a Renesas part-
ner functionality within this integrated program-development process.

1.1 Overview

The Partner OS Aware Debugging Plug-in is an optional product for extending the debugging capabilities of CubeSu-
ite+, and is only for use within CubeSuite+. When debugging a program that has real-time OS functionality, the resource 
information tool of Partner OS Aware Debugging Plug-in can be used to confirm information on real-time OS resources 
(i.e. system information and task information) that change dynamically over time during program execution.

Figure 1-1.   CubeSuite+ Partner OS Aware Debugging Plug-in

1.2 Features

The features of the CubeSuite+ Partner OS Aware Debugging Plug-in are listed below.

- Information from the CubeSuite+ Partner OS Aware Debugging Plug-in can be used to confirm information on 
resources
The Resource Information pane of the Partner OS Aware Debugging Plug-in displays the current states of 
resource information for programs running within the debugging tool.
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1.3 Operation Environment

The features of the CubeSuite+ Partner OS Aware Debugging Plug-in are listed below.

- Real-time operating systems

Table 1-1.   Supported Real-Time Operating Systems

- Integrated Development Environment
CubeSuite+ V1.03

- Debugger
Simulator, on-chip debugging emulator (E1, E20)

- Compilers
Compilers from Renesas Electronics Corporation

- PC
PC running on Windows 7(R), Windows Vista(R), Windows(R) XP
Other conditions comply with the operating environment of CubeSuite+.

Real-time OS RL78 Family RX Family Version

uC/OS-III from  Micrium, Inc. - x V3.02

embOS from SEGGER Microcontroller Systems. - x Version 3.84

UCT uT-Kernel DevKit tuned for RX62N-CubeSuite+ 
from Ubiquitous Computing Technology Corporation

- x Version 1.01.01

NORTi from MiSPO Co., Ltd. - x Version 4 Release 4.4

Smalight OS from Renesas Northern Japan Semicon-
ductor, Inc.

x x V3.10

テキストボックス
For the latest information on operating environments refer to the page below. Operating Environments of Productshttp://www.renesas.com/products/tools/sub/tool_system_requirements.jsp



Partner OS Aware Debugging Plug-in CHAPTER 2   FUNCTIONS

R20UT0946EJ0100 Rev.1.00 Page 8 of 22
Oct 01, 2012

CHAPTER  2   FUNCTIONS

This chapter describes the key functions provided by the Partner OS Aware Debugging Plug-in along with the operating 
procedures.

(1) Start CubeSuite+
Launch CubeSuite+ from the [Start] menu of Windows.

(2) Opening a project
Open the project for debugging.

(3) Selecting the debugging tool
Select the type of debugging tool with which to debug the program.

(4) Downloading a program
Download the program for debugging.

(5) Selecting the real-time OS
When a program is downloaded, the [Select OS] Dialog Box is automatically displayed. At this time, select the real-
time OS you are using.

Figure 2-1.   [Select OS] Dialog Box

(6) Executing/stopping a program
Run the program and then stop it at the location for which you wish to display resource information from the Cube-
Suite+ Partner OS Aware Debugging Plug-in.

(7) Confirm the Resource Information from the Partner OS Aware Debugging Plug-in
Select [View] menu -> [Realtime OS] -> [Resource Information] to open the Resource Information pane.
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Figure 2-2.   [Resource Information] Pane

Remark For details on working with CubeSuite+, refer to the user's manual or help system for CubeSuite+.
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APPENDIX  A   WINDOW REFERENCE

A.1 Description

The pane for the Partner OS Aware Debugging Plug-in is described.

Table A-1.   Pane for the Plug-in

Name of Pane Description

Resource Information pane This pane displays information on the usage of resources (i.e. system information and 
task information) by the real-time OS.
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This pane displays information on the usage of resources (i.e. system information and task information) by the real-time 
OS.

Add further items for display as required by selecting [Add new resource] in the context menu.
Items that can be displayed vary according to the real-time OS.

Figure A-1.   [Resource Information] Pane

The following items are explained here.
- Opening the pane
- Displayed items
- [File] Menu
- [Edit] Menu
- Context Menu

Opening the pane

- From the [View] menu, select [Realtime OS]->[Resource Information].

Displayed items

Resource Information pane

Name of Header Description

Resource Resource type (e.g. Task, Semaphore)

ID Resource ID

Name Symbolic name of the address where a task or handler starts, or the name of a resource

Type Type of resource information, such as "status" and the number of resources

Value Value of resource information

Address Address where the value is stored

Size Size of the value
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[File] Menu

When the [File] menu of CubeSuite+ is selected while the resource information pane is active, the following items are 
displayed for the Resource Information pane.

[Edit] Menu

When the [Edit] menu of CubeSuite+ is selected while the resource information pane is active, the following items are 
displayed in the resource information pane.

Name of Menu Description

Save Resource Data Save the data in the text file (*.txt) in which the context of the pane was previously saved. 
Note that when this item is selected for the first time after booting-up, the operation is the 
same as when selecting [Save Resource Data As ...].

This item is invalid while the program is running.

Save Resource Data As ... Selecting this item opens [Save as ...] dialog box for saving the context of the pane in a 
specified text file (*.txt). 

This item is invalid while the program is running.

Name of Menu Description

Delete Delete an item selected in the pane.

This item is invalid if nothing is selected.

This item is invalid while the program is running.
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Context Menu

The context menu is displayed by right-clicking the mouse on the resource information pane.

Name of Menu Description

Real-time display update 
setting

Selecting this item opens the property pane for setting up updating of the real-time display. 

This item is invalid while a program is running.

Update information Selecting this item updates the information.

Add new resource ... Selecting this item allows registration of a new resource.

The [Select Resource] Dialog Box is displayed.

An added resource is displayed in the lowest line.

Note that the number of resources to be registered on a tabbed page is up to 1000.

This item is invalid while a program is running.

Edit resource ... Selecting this item allows editing of the selected resource.

The [Select Resource] Dialog Box is displayed.

This item is invalid when nothing is selected, and when two or more items are selected.

This item is invalid while a program is running.

Delete Selecting this item deletes the selected item in the pane.

This item is invalid when nothing is selected.

This item is invalid while a program is running.

Notation The following cascaded menu is displayed for specification of the display's notation.

This item is invalid when nothing is selected.

This item is invalid while a program is running.

Automatic Automatically set the notation of the selected item.

Hexadecimal Display the selected item in hexadecimal.

Decimal Display the selected item in decimal.

Jump to source Selecting this item opens an editor pane in which the source code of the task or handler is dis-
played.

This item is invalid when nothing is selected, and when two or more items are selected.

This item is invalid while a program is running.

Select OS ... Selecting this item opens the [Select OS] Dialog Box.

This item is invalid while a program is running.
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[Select Resource] Dialog Box

This dialog box is for select the resource information to be displayed in the resource information pane. One ID number 
or all of the ID numbers can be specified. The items selectable for a resource vary according to the real-time OS.

Figure A-2.   [Select Resource] Dialog Box

The following items are explained here.
- Opening the box
- Selected contents

Opening the box

- Select [Add new resource] or [Edit resource] in the context menu of the Resource Information pane.

Selected contents

Selected item Description

Resource Selecting this item allows selection of the type of resource.

ID number All Selecting this item specifies all of the ID numbers.

Select Selecting this item allows specification of an ID number.

Enter an ID number or click on the [Select] button to open the [Select ID] Dialog Box, 
then select an ID number from the list.

Type Selecting this item allows selection of a type of resource information.
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[Select ID] Dialog Box

Select a resource ID from the list.

Figure A-3.   [Select ID] Dialog Box

The following items are explained here.
- Opening the Box

Opening the Box

- Select the [Select] button in the [Select Resource] Dialog Box.
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[Select OS] Dialog Box

Select the real-time OS that is to be used.

Figure A-4.   [Select OS] Dialog Box

The following items are explained here.
- Opening the box

Opening the box

- This dialog box is automatically opened when a program is downloaded.
- Select [Select OS] in the context menu of the Resource Information pane.
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APPENDIX  B   Messages

In this appendix, the messages output by the Partner OS Aware Debugging Plug-in are explained.
The messages are output to the output pane or in message boxes.

B.1 Fatal Error

Table B-1.   Fatal Errors

B.2 Warning

Table B-2.   Warning

Name Description

E1160020 Message Failure to open a file.

Explanation The plug-in was unable to open a file.

How to cope with Confirm whether the file is or is not accessible.

E1160021 Message Failure to read a file.

Explanation The plug-in was unable to read a file.

How to cope with Confirm whether the file is or is not readable.

E1160022 Message Failure in writing to a file.

Explanation The plug-in was unable to write to a file.

How to cope with Confirm whether the file is or is not writable.

E1160023 Message Failure to close a file.

Explanation The plug-in was unable to close a file.

How to cope with Confirm whether the file is or is not accessible.

Name Description

W1160020 Message The maximum number of resources (one thousand) which can be registered on a tabbed 
page of the resource information pane was exceeded.

Explanation The upper limit on the number of resources which can be registered was exceeded. The 
number of resources which can be registered on a tabbed page is up to one thousand.

How to cope with Delete unnecessary resources or register some of the resources on other tabbed pages 
so that the number on the given page is no greater than one thousand.

W1160021 Message There is not available resource that can be registered.

Explanation The specified resource does not exist. 

How to cope with Specify valid resources. 

W1160022 Message The specified ID number is invalid. 

Explanation The specified ID number does not exist. 

How to cope with Specify valid ID numbers. 
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APPENDIX  C   Notes

This appendix contains cautionary notes.

C.1 Cautionary Notes

Table C-1.   Cautionary Notes

Name Description

General If the Partner OS Aware Debugging Plug-in is to be used, downloaded programs must have been 
assembled or compiled with the output of debugging information.

The debugging function might not operate normally if the build options for the compiler or assembler in 
the tool chain are changed from those provided for use with the OS.

Refer to the pane after initializing the real-time OS.

The pane might not be displayed normally while a program is running.

Smalight OS The task ID "255" means idling of the OS kernel.

uT-Kernel Be sure to set “1” to the minimum ID ( e.g. MIN_TSKID), the minimum priority (MIN_PRI), the debug-
ger support function (USE_DBGSPT) and the object name (USE_OBJECT_NAME) in the configura-
tion files (config.h and config.inc).

uC/OS The debugging function might not operate normally if the contents of the configuration file (os_cfg.h 
and cpu_cfg.h) are changed from the initial values.

The task IDs displayed in this plug-in are internal IDs for debugging, and are different from the task 
IDs of uC/OS.

The maximum task ID number displayable in the resource information pane is 255.

embOS Task names are not displayed while the XR library is in use.

The task IDs displayed in this plug-in are internal IDs for debugging, and are different from the task 
IDs of embOS.

The maximum task ID number displayable in the resource information pane is 255.
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